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About this book

This book provides detailed information on the following subjects:
v Installing and configuring the CommonStore for SAP Client for use with your

SAP R/3 system
v Using the CommonStore for SAP Client

This book is divided into the following parts:
v Part 1, “CommonStore — overview” on page 1. Introduces CommonStore for

SAP.
v Part 2, “CommonStore Client installation” on page 9. Describes the installation of

the CommonStore Client.
v Part 3, “Client customization guide” on page 19. Describes how to customize the

CommonStore Client.
v Part 4, “SAP customization guide” on page 45. Explains how to use the

CommonStore Client for archiving and viewing electronic documents.

Who should read this book
This book is intended for administrators, who are responsible for the deployment
of CommonStore for SAP Clients, and for end users. Administrators should have
in-depth knowledge of CommonStore for SAP and the archive system that they
intend to use.

What’s new in this version
CommonStore for SAP Version 8.1 offers you the following new features:
1. Facility to switch between different server connections. See “Switching server

connections” on page 70.
2. Archiving of documents in FAX format
3. Content Manager Version 8 support.

Release information
The customizing information presented in this book refers to SAP Releases 3.0, 3.1,
4.0, 4.5, 4.6, mySap.com and all subsequent releases.

Conventions and terminology used in this book
This section describes the abbreviations, acronyms, and highlighting conventions
used in this book.

Product names
To facilitate reading, the product name CommonStore for SAP is most of the times
shortened to CommonStore. Content Manager OnDemand is often abbreviated to
CMOD. Likewise, the names ADSM or TSM refer to ADSTAR Distributed Storage
Manager and Tivoli® Storage Manager.

© Copyright IBM Corp. 1999, 2002 v



Throughout this book, the brand name VisualInfo™ refers to the products IBM
EDMSuite™ VisualInfo and IBM Content Manager. The name OnDemand refers to
the products IBM EDMSuite OnDemand and IBM Content Manager OnDemand.

Since SAP Release 3.1, the names of some program components and products have
changed. The change is hinted at on the first occurrence of such a name.

Highlighting conventions
Highlighting is necessary to set product-related terms, product elements, and code
examples off from the text flow. This book uses the following highlighting
conventions

Throughout this book, italics are used for
v Book titles
v Emphasis
v Options / variables / parameters / keywords

Boldface is used for the following elements:
v Check box labels
v Choices in menus
v Column headings
v Commands and subcommands
v Entry fields
v Field names in windows
v Forms and subforms
v Index classes
v Items
v Menu-bar choices
v Menu names
v Radio button names
v Spin button names

Monospace is used for
v Coding examples
v Entered data
v Group and user IDs
v Message text
v Transaction codes (T-codes)

Underlined bold indicates default values.

How to send your comments
Your feedback is important in helping to provide the most accurate and
high-quality information. If you have any comments about this book or any other
CommonStore documentation:
v Visit our home page at http://www.ibm.com/software/data/commonstore/.

There, you find the feedback page where you can enter comments and send
them.

v Send your comments by e-mail to swsdid@de.ibm.com. Be sure to include the
name of the book, the part number of the book, the version of CommonStore,
and, if applicable, the specific location of the text you are commenting on (for
example, a page number or table number).
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v Fill in one of the forms at the back of this book and return it by mail, by fax, or
by giving it to an IBM representative. The mailing address is on the back of the
Readers’ Comments form. The fax number is +49-(0)7031-16-4892.
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List of Abbreviations

The abbreviations used in this document are listed in Table 1.

Table 1. Abbreviations used in this book
ADK Archive Development Kit
ADSM ADSTAR Distributed Storage Manager
AIX® Advanced Interactive Executive (IBM implementation of UNIX)
ALF Advanced List Format
API Application Program Interface
AS/400 Application System/400®

COLD Computer Output on Laser Disk
crontab Chronological Table
DBA Database Administrator
DLL Dynamic Link Library (files with the extension .dll)
DMS Document Management System (Document Administration System)
GUI Graphical User Interface
IAC Internet Application Component
ITS Internet Transaction Server
NT New Technology (Microsoft operating system Windows NT®)
OCR Optical Character Recognition
OLE Object Linking and Embedding
OS/2® Operating System/2®

OS/400® Operating System/400®

OTF Output Text Format (files with the extension .otf)
PDF Portable Document Format (files with the extension .pdf)
R/3 SAP R/3 system
S/390® System/390®

SAP Systems, Applications, Products in Data Processing (software vendor)
TCP/IP Transmission Control Protocol/Internet Protocol
TIFF Tagged Image File Format (files with the extension .tif)
UNIX® An operating system developed at Bell Laboratories
URL Uniform Resource Locator
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Part 1. CommonStore — overview
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Chapter 1. What is CommonStore for SAP

CommonStore and the SAP R/3 Archiving Interfaces

Starting with Release 2.2 of the R/3 system, SAP clearly recognized the
requirement of enhancing R/3 through a robust archiving concept. Step by step,
mechanisms evolved for offloading the operational R/3 database and processing
business documents that reside in an external archiving system. With Release 3.0,
all key applications and modules offered mature archiving functionality that was
shipped as part of the standard R/3 package. These new features leveraged the
power of tools like the SAP Business Workflow, Document Management System,
SAPoffice, SAPconnect, or Archive Development Kit.

While the enhanced application logic for handling external documents is fully
integrated with R/3, SAP decided to leave the core archiving functionality to
established business partners as part of their complementary software program.
The SAP Business Framework provides the interfaces necessary to integrate these
external functions with R/3 and thus create the complete software architecture that
fits the customer’s business processes while protecting software and hardware
investments. With mySAP.com, SAP established a new software partner program
that, like its predecessor, is committed to provide third-party vendors with
integration consulting and standard, release-stable interfaces to connect their
external products to R/3. As the primary interface for integrating storage and
content management systems, BC-AL (SAP ArchiveLink) has been introduced with
Release 2.2 and enhanced in Releases 3.0, 3.1, and 4.5 of the R/3 system.
Additionally, BC-HCS (SAP HTTP Content Server Interface) has been defined in
R/3 Release 4.5 as a subset of BC-AL that focuses on content rather than storage
management. SAP offers its software partners certification for each of these
interface releases.

Only a solution that builds on BC-AL or BC-HCS leverages the archiving potential
of the enabled R/3 modules. IBM Content Manager CommonStore for SAP
(hereinafter referred to simply as CommonStore) is such a solution. While SAP
uses the term optical archive to refer to a system that complies with the BC-AL
specifications, this expression is misleading in that conformance with BC-AL is
independent of hardware components used by the archive supplier (for example,
optical storage media or scanners). In later R/3 releases, the more general wording
external archiving system or external archive appears in SAP publications. This term
will be used throughout this document when referring to products based on
BC-AL.

BC-HCS is a general, cross-application interface that connects the enabled R/3
business applications to a content server and allows them to process documents in
logical content repositories. This content server can be a database, a file server, an
R/3 system, or an external archive like CommonStore. To elucidate the relevance of
BC-HCS in the R/3 archiving context, only the last constellation will be considered
in this section.

The BC-HCS interface is completely based on the industry-standard HTTP
(Hypertext Transfer Protocol); servers and documents are addressed and
parameters and functions are transmitted between CommonStore and the R/3
application server using URLs (Universal Resource Locators). While both concepts
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are typically used to access objects on the World Wide Web, CommonStore
primarily focuses on BC-HCS to exchange content within a corporate intranet.

CommonStore integrates with BC-HCS to perform functions like:
v Storing, updating, or appending documents in a content repository
v Retrieving entire documents or document segments from a content repository
v Obtaining information about documents and their components
v Searching documents for text patterns (without retrieving them)
v Performing attribute-based searches (on print lists, especially journals)
v Deleting documents

To inhibit unauthorized access to archived documents, CommonStore applies
security measures to prevent the forgery or manipulation of URLs and
eavesdropping on contents. These measures include the use of a PKCS#7 digital
signature and public key procedure according to the Digital Signature Standard.
The degree of protection and rights of access to a document can be specified when
a document is stored by R/3.

As the name implies, a content server in the BC-HCS scenario exclusively acts as a
Web server that is contacted by R/3 to perform various functions. Unlike the R/3
system which acts as a Web client, a content server like CommonStore is unable to
instigate communication between the two components.

To support archiving functions and scenarios that cannot be covered by the
client/server perspective BC-HCS is based on, CommonStore supports the
additional protocols covered by BC-AL. In their entirety, the supported BC-AL 4.5
functions (which have not been changed with R/3 Release 4.6 or mySAP.com)
comprise:
v BC-HCS (as described above)
v A BAPI (Business Application Programming Interface) for archiving documents

with bar codes
v OLE (Object Linking and Embedding) functionality for storing inbound

documents or PC files and starting external viewing applications (for example,
archive clients) on 32-bit Windows frontends

When used with R/3 releases prior to 4.5 (the first R/3 release to support
BC-HCS), CommonStore realizes the operations now covered by BC-HCS through
RFCs (Remote Function Calls), a communication protocol defined by SAP. In
releases 4.5 and 4.6, HTTP messages replace the corresponding RFCs.

All BC-AL operations are based on the notion that the SAP database represents a
master index catalog of all documents, including those whose content resides in
the external archive. According to the approach, BC-AL passes no
document-related information to the external archiving system. Instead, a symbolic
UUID (Universal Unique Identifier) is created for each document and applied to
identify it throughout its life cycle. BC-AL itself maintains a table that maps each
business document (for example, credit memo or customer invoice) to its
corresponding UUID. For many SAP users, however, it is a requirement to access
archived documents independently of R/3 or mySAP.com (that is, without using
SAPGUI or the mySAP.com workplace). For this case, to support searching the
external archive for business information like customer number or fiscal year,
CommonStore provides proprietary function modules that transfer these respective
document attributes from R/3 to the archive database.
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Chapter 2. Scenarios and features

As there are diverse applications for archiving and content management in the
SAP R/3 and mySAP.com environments, integrating CommonStore into the SAP
landscape can bring multiple benefits. In the following sections, the most
important aspects will be discussed, distinguishing data archiving (driven by system
administration) and document archiving (driven by business process optimization).

Data archiving
When an R/3 system goes into production, its database usually has a size that
allows efficient storage of data on local hard disks of the database server. While
new data is entered and generated during production, the database size increases
continually. This approximately linear database growth depends on the intensity of
system usage and may easily reach rates of 30 to 50 percent per annum.

This rapid evolution has several inadvertent side effects:
v Since the physical tables are usually stored on hard disks directly attached to the

database server, an increase in hard disk requirements is unavoidable.
v Due to an increase in administration effort for the database, maintenance

windows (for example, for system backup) claim unacceptable amounts of time.
The increased number of rows per database table delays basic operations (for
example, searching tables). The accumulation of these delays leads to a
perceptible degradation of response times when accessing the database.

As practical experience has shown, the database growth noticeably affects the
system performance and administration effort within one to two years of usage.

SAP recommends archiving application data to reduce database growth and
counteract its consequences: “Nearly all customers will thus (have to) archive data
which is no longer needed for online operation.” (translation from the official SAP
document BC – Archivieren und Loschen von Anwendungsdaten as of R/3 Release 3.1).
This process removes mass data from the system which is not actively used.
CommonStore can be employed to perform the task of archiving inactive data
concurrently with normal system operation.

Especially for SAP customers within the European Economic and Currency Union,
the launch of the new Euro currency raises additional issues related to the R/3
database size. Though SAP itself provides the functionality relevant for the LCC
(local currency changeover), this operation still requires system downtime for the
conversion of currency-related database fields. This downtime is approximately
proportional to the respective table sizes. SAP advises: ″Data archiving offers a
way to consistently reduce database tables, therefore you should seriously consider
whether to implement it in the period before local currency changeover.″ (extract
from the white paper SAP Data Archiving and the Euro, Version 3.0). Using
CommonStore to remove inactive currency data from the operational database
minimizes the total conversion downtime and the run time of a database restore in
case the LCC should fail.

Application data archived through CommonStore:
v Can be stored on external media independently of R/3 (for example, optical

media or magnetic tape).
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v Will be compressed by up to a factor of 5 during archival.
v Is accessible by R/3 at any time and can even be analyzed in the external

archive.
v Is not affected by hardware or release changes of the R/3 system.

Document archiving
For legal and/or internal policy reasons, companies are required to keep records
for a certain period of time.

Conventionally filing these documents on paper or in microfiche archives results
in:
v Extensive cost for duplicating or filming the documents to be stored.
v Expenditures for the physical storage of paper or microfiche media.
v Inefficient retrieval of stored documents.

However, most business processes supported by R/3 allow processing documents
electronically (as opposed to a paper-based process).

The benefits of this approach include:
v The ability to use cost-efficient storage media for the document repository.
v Direct access by all authorized users without the delay caused by conventional

archive inquiries.
v Parallel access by several users at the same time.
v The option of leveraging SAP Business Workflow to improve existing work

routines.
v Increased customer satisfaction through optimized processes.

CommonStore is capable of handling different kinds of electronically represented
documents.

The following groups of document types should be differentiated:
v Inbound documents (for example, supplier invoices) that reach the enterprise via

mail or telefax and are stored as rasterized images. For this document type, the
advantages of using CommonStore come to light most apparently.

v Outbound documents, which are normally printed and sent to their respective
recipient. CommonStore not only provides for fast retrieval in case of internal or
external audits, but also for quick referral on inquiries by customers or
suppliers.

v Reports and print lists (for example, journals), which are generated by R/3 and
would normally be printed. The use of CommonStore typically makes a physical
printout obsolete. The electronic journal (as opposed to its paper equivalent) is
easily searchable and can even contain hyperlinks to other documents (as an
example, a specific entry in a document journal might refer to a scanned original
document). Furthermore, the archived lists can be used as input to other
applications like data mining systems.

v Desktop files created by PC applications (for example office, or CAD applications)
can be stored by CommonStore and accessed by R/3 via SAP office or DMS.

In addition to these “basic” document types handled by CommonStore, a typical
requirement for an archiving system is to store documents from external
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applications and make them available to R/3 users. This particularly includes
COLD (computer output on laser disc) that was generated outside of R/3.
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Part 2. CommonStore Client installation
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Chapter 3. Prerequisites

SAP R/3 and archive system installations are in use in companies ranging from
global trusts with very high document volumes to mid-sized companies with a few
hundred invoices per day. This bandwidth is responsible for the large variations in
customer demands regarding performance, availability, and the scalability of the
corresponding systems. CommonStore takes this factor into account by supporting
a wide variety of hardware platforms from which customers are free to choose on
the basis of the demands of the application scenario at hand. While CommonStore
itself runs on AIX, Windows NT, Digital UNIX, HP-UX, OS/400, and, upon request
other platforms, the main archiving load can be distributed among every system
supported by Tivoli Storage Manager, Content Manager OnDemand, or Content
Manager, ranging from an OS/2-based PC to an S/390 mainframe computer.
Through the flexible hardware support offered by Tivoli Storage Manager,
CommonStore also allows the storage of SAP R/3 documents on quite arbitrary
storage media, including hard disks, tape drives, optical media, or corresponding
library systems.

Prerequisites for using the CommonStore Archiving Client
The CommonStore Archiving Client requires the following hardware and software:
v Intel Pentium 166 MHz compatible machine with 32 MB RAM
v Windows NT SP 5, Windows 98, Windows ME, or Windows 2000 SP 1
v Microsoft Internet Explorer 4 or higher
v Microsoft Internet Explorer Plug-Ins for different document types
v CommonStore Server 1.6.x or higher

Prerequisites for using the CommonStore Viewing Client
The CommonStore Viewing Client requires the following hardware and software:
v Intel Pentium 166 MHz compatible machine with 32 MB RAM
v Windows NT SP 5, Windows 95/98, Windows ME, or Windows 2000 SP 1
v For browser viewing:

– Microsoft Internet Explorer 4 or higher, Netscape Communicator 4 or higher
– Browser plug-ins for different document types

v CommonStore Server 1.6 or higher

© Copyright IBM Corp. 1999, 2002 11
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Chapter 4. Installing the CommonStore Client packages

The CommonStore Client consists of the following components:
v The CommonStore Archiving Client is used only for archiving incoming

documents.
v The CommonStore Viewing Client is used only for viewing documents.

Both CommonStore clients require a running CommonStore Server for processing
the archiving, retrieving, and viewing requests.

The CommonStore Archiving Client
The CommonStore Archiving Client is used for the entire communication between
the SAP GUI with the archiving system on 32-bit Windows systems. It is needed
only for archiving incoming documents.

With the CommonStore Archiving Client, scanned documents are archived in
combination with SAP R/3. The CommonStore Archiving Client supports early
(via OLE or RFC call), simultaneous, and late archiving (via bar code, or via OLE).

The CommonStore Archiving Client can handle documents from the following
sources:
v File system (DirQueue)
v Kofax Ascent Capture Release Module (FileQueue)
v VisualInfo workbaskets (VIQueue)

The GUI of the CommonStore Archiving Client is illustrated in Figure 1 on page 14.
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In the left frame of the application window, you can see the queues, which
correspond to the SAP R/3 input area for early, late, and simultaneous archiving.
In the right frame, you can see the documents contained in a queue, the
corresponding recognized bar code, and the date on which the documents have
been scanned. When selecting a document in the left frame, it is displayed in the
right frame.

The CommonStore Archiving Client can archive documents (using the
CommonStore Server) into all supported archive systems:
v Tivoli Storage Manager
v Content Manager
v Content Manager OnDemand

CommonStore supports the document archiving scenarios supplied by SAP:
1. Early archiving: This scenario is used if incoming documents are scanned as

soon as they arrive. The documents are archived from a scan workstation that
runs the CommonStore Archiving Client, which continuously creates work
items in the SAP workflow. Later on a clerk has to enter the booking.

2. Late archiving: Using this scenario, incoming documents routed in paper
format through the company. A clerk enters the booking, applies a bar code on
the paper, and sends the paper document to the archiving department where
the documents are scanned. The bar code is recognized by the scanning
software. Via the CommonStore Archiving Client the documents are archived
and the bar code is sent to R/3, which links the document to the booking.

Figure 1. CommonStore Archiving Client’s GUI

14 CommonStore for SAP: Client Installation and User’s Guide



3. Simultaneous archiving: This archiving scenario works as follows. Incoming
documents are archived when the clerk creates the booking. Therefore the clerk
works with a split screen. On one side is the SAP GUI (enter the booking) and
on the other is the CommonStore Archiving Client (select the corresponding
document). After the clerk entered the booking, the document is archived and
linked automatically.

Installing the package
Load the CommonStore product CD into the CD drive and start the installation
program setup.exe located in the directory CSClient.

Run through the installation procedure and choose the installation path and
language that you want to install.

In the installation directory, the following files will be allocated:
v The CommonStore Archiving Client’s executable, CSClient.exe.
v The CommonStore modules DirQueue.csm, FileQueue.csm, and VIQueue.csm.

These modules will be saved in a subdirectory named Module created during the
installation procedure.

v Sample documents in TIFF format (SAP R/3 document class FAX) located in
subdirectories queues\dir (destined for DirQueue) and queues\file (destined for
FileQueue).

Note
All the settings configured during the setup of the CommonStore Archiving
Client will be written to the Windows registry and the CSClient.INI file.

The CommonStore Viewing Client
The CommonStore Viewing Client is used for viewing SAP R/3 documents with a
customized external viewer, for example a Web browser or the Wang Image
Viewer, by means of Object Linking and Embedding (OLE).

The CommonStore Viewing Client handles the communication:
v With R/3 via OLE
v With the CommonStore Server via sockets

As shown in Figure 2 on page 16, the CommonStore Viewing Client makes it
possible to use external viewers (Alternative 2) other than the standard
ArchiveLink Viewer (Alternative 1) provided by the SAP R/3 System.
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Installing the package
Load the CommonStore product CD into the CD drive. Start the installation
program setup.exe located in the directory CSView.

Run through the installation procedure and choose the installation path and the
language that you want to install.

In the installation directory, the CommonStore Viewing Client executable
CSView.exe will be saved.

When starting the CommonStore Viewing Client manually for the first time, entries
will be made to the Windows registry to make it possible for SAP R/3 to detect
the CommonStore Viewing Client.

Note
All the settings configured during the setup of the CommonStore Viewing
Client will be written to the client configuration profile (default name:
CSClient.ini) situated in the Windows directory.

Figure 2. Standard versus OLE-customized viewing
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Chapter 5. Upgrading to Version 8.1

You must upgrade the CommonStore Archiving Client and the CommonStore
Viewing Client separately. This is described in the subsequent sections.

Upgrading from Version 1.x to Version 8.1
Upgrading from CommonStore Version 1.x to Version 8.1 is performed separately
for the CommonStore Archiving Client and the CommonStore Viewing Client. This
is described in the subsequent sections.

Upgrading the CommonStore Archiving Client
To upgrade the CommonStore Archiving Client from Version 1.x to Version 8.1,
proceed as follows:
1. Install the CommonStore Archiving Client. See also “Installing the package”

on page 15.
2. Set up the CommonStore Archiving Client. When starting up the

CommonStore Archiving Client for the first time, a panel pops up in which
settings according to your environment and your preferences can be entered.
See also “Setting up the CommonStore Archiving Client” on page 21. An initial
setup is mandatory, but can also be changed at any later point in time via the
CommonStore Archiving Client menu selection Setup → Run Setup or
ALT+F8.

3. Create queues in the CommonStore Archiving Client. See also “Creating
queues” on page 25.

4. Save your CommonStore Archiving Client working environment. See also 73.
5. Make sure that the value for the keyword ARCHWINS in the server

configuration profile (default name: archint.ini) is greater than zero.
6. Register the CommonStore Archiving Client application in SAP R/3 (see also

“Registering an OLE application in SAP” on page 58).
7. Load the TypeLib information for the CommonStore Archiving Client (see also

“Loading the TypeLib information” on page 58.
8. Create an ArchiveLink application (see also “Creating an ArchiveLink

application” on page 58).
9. Customize the ArchiveLink application for archiving via the CommonStore

Archiving Client (see also “Customizing the ArchiveLink application for the
CommonStore Archiving Client” on page 58.

10. Open the protocol which had been used up until now to archive with the
CommonStore Client 1.x.

11. Customize the ArchiveLink protocol for archiving via the CommonStore
Archiving Client (see also “Customizing the Archlink protocol for viewing
documents” on page 62.

After having performed the steps described above, the entry in the protocol named
Display object (first entry) must be made to point to the ArchiveLink application
which had been used up until now to archive with the CommonStore Client
Version 1.x.
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The entry for communication step Archive from frontend in the protocol must
now be made to point to the newly-created ArchiveLink application. As a
consequence, archiving calls will now be directed to the CommonStore Archiving
Client Version 8.1.

Upgrading the CommonStore Viewing Client
You can leave the settings in SAP R/3 as they are.

You might consider using browser viewing to have the option of viewing different
types of document classes with the same viewer. You should therefore refer to
“Setting up the CommonStore Viewing Client” on page 33 for more information.

Upgrading from Version 2.1.x to Version 8.1
Upgrading from CommonStore Version 2.1.x to Version 8.1 is performed separately
for the CommonStore Archiving Client and the CommonStore Viewing Client. This
is described in the subsequent sections.

Upgrading the CommonStore Archiving Client
To upgrade the CommonStore Archiving Client from Version 2.1.x to Version 8.1,
proceed as follows:
1. Ensure that you saved your working environment, which can be done by the

menu path File → Save As.
2. Install the CommonStore Archiving Client Version 8.1. See also “Installing the

package” on page 15.
3. Run the CommonStore Archiving Client Version 8.1. When staring up the

CommonStore Archiving Client for the first time, a panel pops up in which
settings according to your environment and your preferences can be entered.
See also “Setting up the CommonStore Archiving Client” on page 21.

All other settings remain the same as in Version 2.1.x and should have been done
when the CommonStore Archiving Client Version 2.1.x was installed.

Upgrading the CommonStore Viewing Client
To upgrade the CommonStore Viewing Client from Version 2.1.x to Version 8.1,
proceed as follows:
1. Install the CommonStore Viewing Client Version 8.1. See also “Installing the

package” on page 16.
2. Run the CommonStore Viewing Client Version 8.1. When the CommonStore

Viewing Client setup dialog pops up, you can enter the settings according to
your environment and your preferences. For detailed information see “Setting
up the CommonStore Viewing Client” on page 33.

All other settings remain the same as in Version 2.1.x and should have been done
when the CommonStore Viewing Client Version 2.1.x was installed.
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Part 3. Client customization guide
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Chapter 6. CommonStore Archiving Client

You must customize the components of the SAP Client separately. This chapter
explains how to customize the CommonStore Archiving Client.

Getting started
The following steps need to be performed before you can start archiving with the
CommonStore Archiving Client:
1. Install the CommonStore Archiving Client. See also “Installing the package” on

page 15.
2. Perform the CommonStore Archiving Client setup. When starting up the

CommonStore Archiving Client for the first time, you will be guided through a
number of setup panels in which you can enter settings according to your
environment and your preferences. See also “Setting up the CommonStore
Archiving Client”. An initial setup is mandatory, but you can change the setup
at any later point in time via the CommonStore Archiving Client menu
selection Setup → Run Setup or Alt+F8.

3. Create queues in the CommonStore Archiving Client. See also “Creating
queues” on page 25.

4. Save your CommonStore Archiving Client working environment. See also 73.
5. Make sure that the value for the keyword ARCHWINS in the CommonStore

Server configuration profile (default name: archint.ini) is greater than zero.
6. For archiving via OLE, run through the SAP customizing procedures needed

for Early archiving via OLE explained in Chapter 9, “Early archiving via OLE”
on page 47.

Setting up the CommonStore Archiving Client
When running the CommonStore Archiving Client for the first time you will be
notified and the setup dialog is started automatically.

Start the setup panel by clicking Setup → Run Setup on the main menu or
alternatively by pressing Alt+F8. On the panel shown in Figure 3 on page 22, you
must enter various settings. Clicking the OK button initiates a validity check. If the
settings are correct, they are saved. Clicking the Cancel button leaves all settings
unchanged and closes the panel.

Note
When you launch the setup panel, the connection to the specified
CommonStore Server is checked and the connection status information on the
setup panel (icon) and on the status bar is refreshed.
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Server connection
This group holds all connection-related settings.

Archive Host/IP
address

Name or IP address of the machine that the CommonStore Server is
running on. The default value is 127.0.0.1.

Port Port number specified in the CommonStore Server configuration file
(default name: archint.ini) under the keyword ARCHWIN_PORT.
Default value is 5500.

Webport Port number specified in the CommonStore Server configuration file
(default name: archint.ini) under the keyword WEBPORT.

Note:

The WebPort field will be filled automatically if you are connecting to the CommonStore
Server after clicking either the Test or OK button and a connection could be established. If
you are using version 2.1.x or lower of the CommonStore Server, you must fill in the correct
WebPort manually.

Figure 3. CommonStore Archiving Client setup dialog
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Test You can use the Test button to check the connection between the
CommonStore Archiving Client and the CommonStore Server. If a
connection can be established, you see a green circle right beside the
button and in the status bar:

If a connection cannot be established, you see a red cross:

Work path
The Work path is set to the installation directory by default but can be changed if
necessary. The CommonStore Archiving Client uses this directory for processing
various tasks. Temporary files will be allocated in this directory. Enter the directory
name either manually or use the directory browser button.

Modules
Depending on which scanning application is being used to scan in the paper
documents, the electronic information concerning these documents will be
allocated in different ways. The CommonStore Archiving Client supports the
following types of scanning applications:
1. Scanning applications which merely create the electronic documents in a

specified directory. The DirQueue module is used for this scenario.
2. Scanning applications which create a description file in addition to the

electronic documents. For each scanned document, an entry is added to the
description file. Depending on the configuration of the scanning application,
you can also use Optical Character Recognition (OCR). The recognized
information is then saved in the description file as part of the entry for the
scanned document. An entry created in, for example, the Kofax Ascent Capture
description file, looks like this:
"Bar codes","1289003","d:\CSClient\queues\invoices\doc1.tif"

3. Where 1289003 is the recognized bar code and
"d:r\sclient\queues\invoicesr\oc1.tif" is the fully qualified file name of the
electronic document created by Kofax Ascent Capture. The FileQueue module
is used for this scenario. You get a description file in the format shown above,
even if you do not use Kofax Ascent Capture.

4. Scanning applications that scan documents and transfer them directly to a
Content Manager workbasket. Use the VIQueue module for this scenario.

These modules reside in the subdirectory module of the installation directory. They
are on the Modules list, where the module name and the status are shown. When
you are start the CommonStore Archiving Client for the first time, all modules
have the status Not Loaded.

Depending on which scanning scenario you are using, check the box in front of the
according modules so that the module status turns from Not Loaded into Loaded.
You can select more than one module.

Chapter 6. CommonStore Archiving Client 23



Note
If the modules located in the subdirectory module have not the same version
as the CommonStore Archiving Client, the module status is Wrong Version.
This can occur if you have not installed the CommonStore Archiving Client in
the right way.

Bar code
During late archiving, documents will be archived via the CommonStore Archiving
Client. For each document, this is basically a two-step action. The electronic
document will be archived first. The bar code together with the archive document
ID will then be sent to the SAP system if archiving was successful.

For mass archiving, you can optimize the performance by specifying the number of
bar codes which are to be transferred together in one batch to the SAP system,
thus eliminating the need for establishing separate links for each single document.
This bundling effect will be achieved by entering a value greater than 1 for the
number of bar codes. The maximum number of bar codes to be sent in one batch is
50.

Version information
This group displays the versions of the CommonStore Archiving Client, the
CommonStore Server API (CSClient.dll), and the CommonStore Server if a
connection is established.

Document format sent to SAP
When you want to view an archived document, you usually click the appropriate
business object on the SAP GUI. In doing so, you start a viewing application that
displays the document.

In SAP R/3 versions prior to 4.0, you can associate a viewing application with an
archived document only if the document format registered in SAP is FAX. This
was changed in later versions, which allow you to associate a variety of formats
with external viewing applications.

Therefore, if your R/3 version is 4.0 or higher, check the As configured in queue
setup box. If your SAP R/3 version is older, leave the box unchecked.

Logging and tracing
The CommonStore Archiving Client provides logging and tracing facilities. If
logging is enabled, the CommonStore Archiving client writes a protocol with
information about the performed actions into a log file. In case of errors, additional
information is added to the log file. For more detailed information, enable the
tracing facility. It writes detailed information into a trace file. Only enable the
tracing facility if errors occurred because tracing lowers the performance. In error
cases the CommonStore Server API tracing facility can be enabled to get more
detailed information about the communication steps between the CommonStore
Archiving Client and the CommonStore Server.

In front of the text field for each file name there is a check box for enabling or
disabling the according facility. If a facility is disabled, the affected fields are
grayed out.
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Log File Enter the full path and the file name of the log file, for example:

C:\CSClient\CSClient.log

You can also use the file browser right beside the text field.

API trace file Enter the full path and the file name of the API.

Client trace file Enter the full path and the file name of the trace file, for example:

C:\CSClient\CSClient.trc

You can also use the file browser right beside the text field.

Maximum file
size

Enter a maximum size in kilobytes to limit the disk space that the trace
file can occupy. If the specified size is exceeded, the trace file will be
truncated.

Clear trace file Enable this check box only if you want to clear the trace file each time
the CommonStore Archiving Client is started. It is recommended that
the trace file is not cleared (unchecked). This is because if ever highly
intermittent errors occur, as much data as possible about all preceding
actions is needed to be able to analyze the cause.

If all settings have been customized, commit them by clicking the OK button or by
pressing the ENTER key. Your entries are verified and the connection to the
CommonStore Server is checked. If the verification runs without errors, the dialog
box is closed. If errors occur, you receive an error message. You can discard your
changes by clicking the Cancel button or by pressing the ESC key.

Creating queues
To separate the different types of documents, you must create a queue for each
document type. For example, if you intend to work with invoices, create a queue
named Invoices for archiving scanned invoices. Or, if you intend to work with
orders, create a queue named Orders for scanned orders.

To create a queue, click Queue → New Queue or press Ctrl+1 to start a wizard
leading you through the following sequence of panels:
1. Queue
2. One of the following panels, depending on the queue type you selected on the

Queue panel:
v Directory Queue
v File Queue
v Content Manager Queue

3. Connection Properties
4. End

The settings that you must enter on each panel are discussed in the following
sections.
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In this panel, you specify the settings for the queue, as follows:

Queue Type Choose the module corresponding to your type of scanning application
(see also “Modules” on page 23). In the drop-down list, you can choose
only from a list of modules which have already been loaded. Modules
can be loaded in the setup dialog (see “Setting up the CommonStore
Archiving Client” on page 21).

Queue Name Enter a name that reveals the purpose of this queue, such as Invoices, if
this queue will be used to archive incoming invoices. This field needs
not to be entered if you have chosen the queue type Content Manager
Queue.

Document Format Due to the fact that, in earlier releases, SAP supported only a restricted
number of document formats, CommonStore offers the possibility of
extending the list of formats which can be displayed, provided OLE
and browser viewing are used for displaying the document. This can be
done as follows:

Figure 4. The Queue panel
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1. In SAP, customize the OLE for FAX document class for the
following functions:

v Archiving. See Chapter 17, “Perform early archiving with OLE”
on page 79.

v Viewing. See Chapter 20, “Viewing documents via OLE” on
page 85.

2. In the CommonStore Archiving Client, you must choose the format
of the of the documents in that queue when setting up a queue, for
example GIF for documents in Graphics Interchange Format format.

Notes

v Select the appropriate radio button for the document class
in the SAP customizing, for example FAX if you want to
customize viewing documents archived in TIFF format or
PDF if you want to customize viewing documents archived
in PDF format.

v Not all document formats are supported by all versions of
the CommonStore Server. The CommonStore Archiving
Client will therefore display a list of document formats
corresponding to the supported formats of the
CommonStore Server version to which it is connected.

v When archiving a document, the CommonStore Server
receives information on the document’s real format (for
example GIF) and saves this information.

3. If browser viewing is used by the CommonStore Viewing Client, the
CommonStore Server checks for the saved format information when
receiving a call for displaying an archived document, and sends
format information to the Web browser, which in turn launches the
proper plug-in for that document format.

Note
The plug-in must be installed and registered with the browser
on the viewing workstation.

The CommonStore Server sends format information to the Web browser
by setting the MIME type. With the CommonStore Server package, a file
named csmimes.properties is installed. This file contains the 1-to-1
mapping of the document format to the corresponding MIME types.

Excerpt from the CommonStore Server file csmimes.properties:

FAX=image/tiff
PDF=application/pdf

If these MIME types do not correspond to your environment, edit the
entries appropriately.

Document type The CommonStore Archiving Client is able to perform Early Archiving
without OLE and not triggered from SAP GUI as in previous releases.
Therefore you have to specify the SAP WFL document type that should
be used for Early Archiving. When archiving incoming invoices you
specify, for example, FIIINVOICE.
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SAP R/3 archive Enter the name which is customized in R/3 (transaction code OAC3) for
the SAP document class that is to be handled by this CommonStore
Archiving Client queue.

Check matching If this check box is enabled, the system always checks during archiving
via Object Linking and Embedding (OLE) whether the specified SAP R/3
archive ID corresponds to the archive ID received with the OLE call. It is
recommended that you enable this checking facility.

Important
You cannot create a queue while automatic processes are running.

Module-dependent settings
Depending on the module which you selected under Queue Type in the Queue
panel, one of the following panels for entering module-dependent settings will
appear.

Directory Queue panel

Enter the following settings:

Path name Path where the CommonStore Archiving Client expects the
electronic documents to be created by the scanning application. For
example, if the scanning application is set up to create electronic
documents representing invoices in the directory
c:\CSClient\Invoices, then enter this path. You can browse
through the file system using the directory browser button.

Use file name as bar
code

If this check box is enabled, the file’s name is used as the bar code.
If it is disabled, there is no information about the bar code.

Figure 5. The Directory Queue panel
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File Queue panel

Enter the following settings:

Path name for the description
files

Path where the CommonStore Archiving Client expects the
scanning application to create the description files for the
documents handled by this queue. For example, if the
scanning application is set up to create the description files
for scanned invoices in the directory c:\CSClient\Invoices,
you must enter this path. You can browse through the file
system using the directory browser button.

Extension of description files Enter the name of the extension of the description files.
Thus, if the description file is named, for example,
batch1.txt, enter txt in this field.

File column Enter the number of the column which holds the file name
in the description file.

Bar code column Enter the number of the column which holds the bar code
in the description file. Enter 0 if the bar code information is
to be ignored. Take, for example, an entry in the description
file with the following appearance:

"Barcodes""1289003""d\CSClient\queues\invoices\doc1.tif"

It is obvious that (counting from left to right) the word
Barcodes is in column 1, the current bar code value is in
column 2, and the fully qualified name (path and file name)
of the file is in column 3. Therefore, set the following
values:
File column 3
Bar-code column 2

Figure 6. The File Queue panel
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Content Manager Queue panel

When using the Content Manager module (VIQueue), only documents from
Content Manager workbaskets configured in the server configuration profile can be
processed.

Enter the following settings:

Workbasket The Workbasket box lists all Content Manager workbaskets,
available by the contacted CommonStore Server. If there are
no scan workbaskets customized in the CommonStore Server,
a message is displayed. You have to change the
CommonStore Server settings (default name: archint.ini).

Queue name The name of the queue is received from the CommonStore
Server automatically when choosing a workbasket from the
list. The queue name can be changed manually if necessary.
Changing the name does not affect the settings in the
CommonStore Server.

Maximum number of items The maximum number of document items retrieved by one
call, when importing documents from a Content Manager
queue.

Receive attributes Select this check box to retrieve additional information (bar
code and scan date) of the documents when importing them.
Since this is a performance-relevant action, you are given the
option of declining this offer if you do not need the
information. This might be the case when you want to
archive via OLE or perform early archiving w/o OLE.

Connection Properties panel

Figure 7. The Content Manager Queue panel
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The Connection Properties panel allows you to select a server connection of your
choice for the queue. Enter the following settings:

Archive Host/IP Address The name of the CommonStore Server that you want to
connect to. You can enter the short name, the full name, or
the IP address.

Port The number of the port that is used for client/server
communication regarding archiving and retrieval jobs. This
port uses a TCP/IP connection. The actual value depends on
the individual setup. Ask the administrator of the
CommonStore Server for the correct port number if you do
not know it. It is a 4-digit number that is greater than 5000.

WebPort The number of the port that is used for client/server
communication regarding the display of archived documents.
Client and server communicate by using the Hypertext
Transfer Protocol (HTTP), which is why the port is called the
WebPort. The actual value depends on the individual setup.
Ask the administrator of the CommonStore Server for the
correct port number.

Important

v You cannot change the server connection of a Content Manager queue
because Content Manager queues always use the preferred server connection.

v You cannot select a server connection for a queue while automatic
processes are running.

Figure 8. The Connection Properties panel
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End panel
Press the Finish button to make the newly allocated queue available in the
CommonStore Archiving Client. If you decide not to create the queue during the
previous steps, click the Cancel button and everything is discarded and the wizard
will be closed.

Distributing the CommonStore Archiving Client to other PCs
If you do not want to run through the CommonStore Archiving Client installation
and setup procedure for each PC on which it is to be installed, the following steps
must be performed:
1. Perform the primary installation as described in “Installing the package” on

page 15.
2. Run through the setup and enter your settings as described in “Setting up the

CommonStore Archiving Client” on page 21.
3. Click Setup → Save settings to file to save the settings for the CSArch.ini file.
4. Copy the CommonStore Archiving Client installation directory to the other PCs.
5. Copy the CommonStore API-DLL (that is, CSClient.dll), which is located in the

windows system directory, to the other PCs.
6. Copy the previously created file CSArch.ini into the installation directory on

the other PCs.
7. Run the CommonStore Archiving Client on the other PCs for taking the settings

from the CSArch.ini into the Windows registry.
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Chapter 7. CommonStore Viewing Client

You must customize the components of the SAP Client separately. In “Getting
started”, you find a list of the necessary steps for the CommonStore Viewing
Client. Each step is described in detail in “Setting up the CommonStore Viewing
Client”.

Getting started
You must perform the following steps before you can use the CommonStore
Viewing Client:
1. Install the CommonStore Viewing Client. See “Installing the package” on

page 16.
2. Perform the CommonStore Viewing Client setup. See “Setting up the

CommonStore Viewing Client”.
3. Make sure that the value for the keyword ARCHWINS in the CommonStore

Server profile (that is, archint.ini) is greater than zero.
4. For viewing documents via OLE, run through the customization procedure

explained in Chapter 12, “Viewing documents via OLE” on page 53.

Setting up the CommonStore Viewing Client
Every time you run the CommonStore Viewing Client, the setup dialog is launched
automatically. If this is the first time you run the CommonStore Viewing Client it is
necessary to do some basic settings that might be changed later.

Note
It is recommended that you use the path of the installation directory as the
work path and as the location of all CommonStore Viewing Client files (trace
file, API-DLL trace file, log file) to have all of the files at the same location.

You must enter various settings on the panel that comes up. Clicking the OK
button initiates a validity check. If the settings are correct, they are saved. Clicking
the Cancel button leaves all settings unchanged and closes the panel.

Note
When you launch the setup panel, the connection to the specified
CommonStore Server is checked and the connection status information on the
setup panel (icon) and on the status bar is refreshed.

Server connection
This group holds all connection-related settings.

Archiving Host/IP
Address

Name or IP address of the machine on which the CommonStore
Server is running. The default value is 127.0.0.1.
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Port Port number specified in the server configuration file (default name:
archint.ini) under the keyword ARCHWIN_PORT. The default value
is 5500.

Test You can use the Test button to check the connection between the
CommonStore Viewing Client and the CommonStore Server. If a
connection can be established, you see a green circle right beside the
button and in the status bar:

If a connection cannot be established, you see a red cross:

Important
You cannot select a server connection for the Viewing Client
while automatic processes are running.

Figure 9. CommonStore Viewing Client Setup
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Work path
The work path is set to the installation directory by default but can be changed, if
necessary. The CommonStore Viewing Client uses this directory for processing
various tasks. Temporary files will be allocated in this directory.

Enter the directory name either manually or use the directory browser button.

Viewing
Beginning with release 2.x of the CommonStore Viewing Client, it is possible to
choose between browser viewing or a non-Web viewer for displaying documents
via OLE.

Browser viewing Select this radio button if you want to use Browser viewing. This facility
is enabled only if the CommonStore Server is reachable.

WebPort The WebPort is filled in automatically if you click
the Test button and the CommonStore Server can
be reached assuming you are connecting to a
version 7 CommonStore Server. Otherwise you
have to enter the WebPort manually.

Enhanced
functionality

If this check box is disabled just the document will
be displayed. Otherwise, when displaying the
requested document, buttons will be supplied for
extra features like the Process note and the Mailing
applet.

Web viewer Enter the full qualified file name of the browser
which should be used for viewing documents or
browse the file system using the file browser
button. By default the Netscape Communicator is
used.

Native Viewing Select this button if you want to use as native viewing application.

Native viewer Enter the full qualified file name of the application
which should be used for viewing documents or
browse the file system using the file browser
button. By default the Wang Image Viewer is used.

File and viewer management
To display the requested documents, the CommonStore Viewing Client allocates
temporary files in the file system and launches the viewer as configured.

Starting with SAP Release 4.5, SAP has changed the strategy of sending close calls
to viewers. The viewer and file management has therefore been extended to handle
this new behavior. If the check box is enabled, the CommonStore Viewing Client
reacts to the received closing calls. Reacting to the closing calls refers to deleting
temporary files from the file system and closing all the viewers launched by the
CommonStore Viewing Client. If the check box is disabled, the CommonStore
Viewing Client keeps the launched viewers open and does not delete the
temporary files.

To make displaying less error-prone for SAP users, it is possible to display only
one document at a time. This prevents the SAP user from entering a wrong
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booking by looking at a wrong document. To enable this single display mode, you
will need to customize the SAP OLE function as specified in “Customizing the
ArchiveLink application for closing a viewer window” on page 62.

Version information
This group displays the versions of the CommonStore Viewing Client, the
CommonStore Server API (CSClient.dll), and the CommonStore Server if a
connection is established.

Logging and tracing
The CommonStore Viewing Client provides logging and tracing facilities. If
logging is enabled, the CommonStore Viewing Client writes a protocol with
information about the performed actions into a log file. In case of errors, additional
information is added to the log file. For more detailed information, enable the
tracing facility, which writes more detailed information into a trace file. Keep in
mind, however, that tracing lowers the performance. Therefore, only use it when
encountering errors.

If errors do occur, you can additionally enable the CommonStore Server API
tracing facility to obtain special information about the communication between the
CommonStore Viewing Client and the CommonStore Server.

In front of the text field for each file name there is a check box for enabling or
disabling the according facility. If a facility is disabled, the affected fields are
grayed out.

Log File Enter the full path and the file name of the log file, for example:

C:\CSClient\CSView.log

You can also use the file browser right beside the text field.

API trace file Enter the full path and the file name of the API-DLL trace file, for
example :

C:\CSClient\DLL.trc

You can also use the file browser right beside the text field.

Client trace file Enter the full path and the file name of the trace file, for example:

C:\CSClient\CSView.trc

You can also use the file browser right beside the text field.

Maximum file
size

Enter a maximum size in kilobytes to limit the disk space that the trace
file can occupy. If the specified size is exceeded, the trace file is
truncated. The maximum size you can enter is 10240 KB.

Clear trace file Enable this check box only if you want to clear the trace file each time
the CommonStore Viewing Client is started. It is recommended that the
trace file is not cleared (unchecked). This is because if ever highly
intermittent errors occur, as much data as possible about all preceding
actions is needed to be able to analyze the cause.

When you made the necessary changes, commit them by clicking the OK button or
by pressing the ENTER key. Your entries are verified and the connection to the
CommonStore Server is checked. If the verification runs without errors, the dialog
box is closed. If errors occur, you receive an error message. You can discard your
changes by clicking the Cancel button or by pressing the ESC key.
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Distributing the CommonStore Viewing Client to other PCs
If you do not want to run through the CommonStore Viewing Client installation
procedure for each PC on which it is to be installed, perform following steps:
1. Perform the primary installation as described in “Installing the package” on

page 16.
2. Run through the setup and enter your settings as described in “Setting up the

CommonStore Viewing Client” on page 33.
3. Propagate (copy) the installation directory of the CommonStore Viewing Client

to the other PC.
4. Propagate the CommonStore DLL (that is, CSClient.dll), which is located in the

Windows directory, to the other PC.
5. Propagate the client configuration profile to the other PC. This profile must be

named CSClient.ini and must reside in the Windows directory for it to be
taken into account by the CommonStore Viewing Client.

6. The CommonStore Viewing Client must be started at least once on the other PC
to register itself in the Windows registry.
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Chapter 8. CommonStore API-DLL

The CommonStore API-DLL is an intermediate layer located between applications
on end-user workstations and the CommonStore Server. It is used by the following
programs:
v CommonStore Archiving Client
v CommonStore Viewing Client
v SAP ArchiveLink viewer

These applications use the CommonStore API-DLL to contact the CommonStore
Server when archiving documents or requesting documents for viewing.

The CommonStore API-DLL is part of the CommonStore Viewing Client package
as well as of the CommonStore Archiving Client package and is copied to the
Windows system directory during the installation. The DLL needs the
CommonStore Client configuration profile (that is, CSClient.ini) to run, but only
the settings of the keywords in section [ARCHPRO_CONNECTIONPARAMETER]. The
parameters for establishing the connection to the CommonStore Server are:

Server Name or TCP/IP address of the machine on which the CommonStore
Server is running.

Port Port number specified in the server configuration profile (that is,
archint.ini) under the keyword ARCHWIN_PORT.

The CommonStore API-DLL supports a separate detailed tracing of all
CommonStore API-DLL function calls. DLL tracing should be activated only in
case of error situations. API-DLL tracing is controlled by the following keywords:

DLLTracefile
Fully qualified file name (path and file name) of the API-DLL trace file, for
example:
c:\CSClient\CSDll.trc

DLLTracelevel
Enter 0 to disable API-DLL tracing or 1 to enable tracing.

DLLTraceMax
Specifies the maximal size of the API-DLL trace file in KB. The default
value is 1024, meaning 1 MB.

Viewing documents with the SAP ArchiveLink viewer
For the exclusive use of the ArchiveLink viewer for displaying documents, no
parameters in the client configuration profile CSClient.ini other than those
specified above are required.

To enable viewing via the ArchiveLink viewer, you must ensure that the
ArchiveLink functionality, too, is installed on the workstation when installing the
SAP GUI. For this reason, the clicker for ArchiveLink must be enabled in the SAP
GUI installation procedure.

After finishing the installation of the SAP GUI, configure the installation by
running the program setup_al.exe. You will be asked for an archive ID and the
DLL of the archive vendor (that is, CSClient.dll). For releases 3.x of setup_al.exe,
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you must explicitly specify each archive ID contacted for viewing.Starting with
release 4.0, you can keep default as the archive name to contact CSClient.dll for
all viewing calls.

The setup_al.exe program configures the following files:
v archlink.ini
v alviewer.ini

After the setup procedure, archlink.ini and alviewer.ini contain the entries
specified in Figure 10 and Figure 11 on page 41.

After the setup, make sure that the sections displayed in boldface in Figure 10 and
Figure 11 on page 41 fit your environment.

[ArchiveLink]
Archives=A1,AR,D1,CN,
Path=D:\programs\sapgui\archlink\
DisplayTypes=FAX,OTF,ALF
[Logging]
LogFile=ALINKLOG.TXT
MaxFileSize=100000
LogLevel=500
[Archive-A1]
ArchiveLinkDLL=CSClient.dll
[Archive-AR]
ArchiveLinkDLL=CSClient.dll
[Archive-D1]
ArchiveLinkDLL=CSClient.dll
[Archive-CN]
ArchiveLinkDLL=CSClient.dll
[Scan]
DdeService=viscan
DdeTopic=viscan
[FAX]
DdeService=SAPArchiveLink
DdeTopic=*
Path=ALVIEWER.EXE
[OTF]
DdeService=SAPArchiveLink
DdeTopic=*
Path=ALVIEWER.EXE
[ALF]
DdeService=SAPArchiveLink
DdeTopic=*
Path=ALVIEWER.EXE

Figure 10. Sample excerpt from archlink.ini
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For further information, refer to the SAP WF ArchiveLink manual on the SAP
Documentation Print Files CD-ROM and the description of the ALSETUP program
on the SAP Presentation CD-ROM.

Note
The features described in “Viewing documents from multiple SAP systems”
and “Caching at the client side” on page 42 are optional. Do not add the
entries specified in these two sections if you do not need the features, as this
may have an impact on the performance.

Viewing documents from multiple SAP systems
When using the settings in the client configuration profile CSClient.ini, only that
instance of CommonStore Server identified by the settings for ’Server’ and ’Port’
will be contacted. As a consequence, only the documents of that R/3 System can
be displayed which is served by the specified CommonStore Server.

To allow viewing of documents from multiple R/3 systems, the CSClient.dll
needs to connect to multiple CommonStore Servers, since one CommonStore Server
connects to only one SAP system. This means that the API-DLL will contact in a
round-robin procedure a specified set of CommonStore Servers for handling a
certain request. In general, the CommonStore Server which could successfully

[AlViewer]
Path=D:\programs\sapgui\archlink
Archives=A1,AR,D1,CN,
x=451
y=73
dx=769
dy=537
[Logging]
LogFile=ALINKLOG.TXT
MaxFileSize=100000
LogLevel=500
[ImageDisplay]
MinResolution=60
BackgroundColor=192,192,192
ScaleAlwaysToWindow=0
ScaleToGrey=0
LeftMouseAction=1
[International]
D=DEU
E=ENG
X=DEU
[InitialLanguage]
LanguageMarker=D
[IxMemo]
BackgroundColor=255,255,64
Signature=\n © %D.%M.%Y, %h:%02m %[SAPUSER] \n
[Cache]
MaxFiles=50
[Archive-A1]
ArchiveLinkDLL=CSCLIENT.DLL
[Archive-CN]
ArchiveLinkDLL=CSCLIENT.DLL
[Archive-AR]
ArchiveLinkDLL=CSCLIENT.DLL
[Archive-D1]
ArchiveLinkDLL=CSCLIENT.DLL

Figure 11. Sample excerpt from alviewer.ini
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handle a request becomes the so-called active CommonStore Server. The next
request is always sent first to the active CommonStore Server. If it is not possible
to retrieve the requested document from the active CommonStore Server instance,
the next CommonStore Server will be contacted until this request is handled
successfully or all of the listed CommonStore Servers have been contacted. The
CommonStore Server which handled the request successfully will again be set
active and the next request will be sent to this CommonStore Server instance. If the
request finishes successfully, the document will be displayed. An error message
will be sent to the SAP system only when all listed CommonStore Servers have
returned an error.

For all CommonStore Servers which need to be contacted from the current
workstation, add entries to the client configuration profile CSClient.ini, for
example:

Server:
Name or IP address of the first instance of the CommonStore Server

Port: Port of the first instance of the CommonStore Server

Server_2:
Name or IP address of the second instance of the CommonStore Server

Port_2:
Port of the second instance of the CommonStore Server

The dynamic link library CSClient.dll reads the settings starting with the settings
for ’Server’ and ’Port’, continuing with ’Server_2’ and ’Port_2’, and so on. The first
entry will be used when the first call arrives.

Notes

v The order in which these entries are specified is not important, for
example: You can specify 'Server_2' and 'Port_2', 'Server' and 'Port', and
then 'Server_3' and 'Port_3'.

v The entries will be read until a gap is encountered. Thus, if you have
specified 'Server' and 'Port', 'Server_2' and 'Port_2', and then 'Server_4' and
'Port_4', the API-DLL takes only the first two entries into account.

When multiple instances of the CommonStore Server are customized in the client
configuration profile CSClient.ini, it is recommended that you deactivate the
message box of the API-DLL, which pops up in case of a connection error to a
CommonStore Server. This is achieved by setting the parameter Interactive=0 (see
Figure 12 on page 43). The default is Interactive=1.

Caching at the client side
The CommonStore API-DLL supports the caching of retrieved documents at the
end-user workstation. When caching is enabled, complete documents and the
query information are stored in the local cache.

Caching is enabled by the keyword CachePath specifying the directory for the cache
(when left empty, caching is disabled). This directory must exist, or else caching is
disabled. CachePath should specify a separate directory, since all files in the cache
are deleted when the CacheMax limit is exceeded. CacheMax specifies the maximal
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size of the cache in KB. When the total size of all files in the cache exceeds this
limit, all files are deleted before the next file is stored in the cache.

CachePath
Specifies the directory for the cache. The directory must exist.

CacheMax
Specifies the maximum size of the cache in KB. The default value is 10 240,
meaning 10 MB.

The following excerpt from the client configuration profile CSClient.ini shows
example settings for the API-DLL topics discussed in this chapter.

Important
If you view archived documents in a Web browser, caching at the client side
does not work because the browser retrieves the data independently of the
DLL cache.

[ARCHPRO_CONNECTIONPARAMETER]
Server = w3362117
Port = 5500
Server_2 = w3362117
Port_2 = 5502
Server_3 = archifix
Port_3 = 8017

DllTracefile=E:\CSClient\dll.trc
DllTraceLevel=1
DllTraceMax=1024

Interactive=0

CachePath=E:\CSClient\cache
CacheMax=10240

Figure 12. Sample excerpt from the client configuration profile (CSClient.ini)
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Part 4. SAP customization guide
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Chapter 9. Early archiving via OLE

Early archiving via OLE is an SAP archiving scenario for incoming documents
including the SAP Business Workflow. To get this scenario working, you need to
proceed as follows:
1. Set up the SAP workflow parameters and document types. See also Chapter 14,

“Collection of SAP customizing steps” on page 57.
2. Register the CommonStore Archiving Client application in the SAP system. See

also “Registering an OLE application in SAP” on page 58.
3. In SAP Release 3 you need to load the TypeLib information for the

CommonStore Archiving Client. See also “Loading the TypeLib information” on
page 58.

4. Create an ArchiveLink application for the CommonStore Archiving Client. See
also “Creating an ArchiveLink application” on page 58.

5. Customize the ArchiveLink application for archiving via the CommonStore
Archiving Client. See also “Customizing the ArchiveLink application for the
CommonStore Archiving Client” on page 58.

6. Create an ArchiveLink protocol. See also “Creating an ArchiveLink protocol” on
page 59.

7. Customize the ArchiveLink protocol for archiving via the CommonStore
Archiving Client. See also “Customizing the ArchiveLink protocol for archiving
via the CommonStore Archiving Client” on page 60.

8. Create an entry in the link table for the document type used for early
archiving. See also “Creating an entry in the link table for the document type
used for early archiving” on page 59.
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Chapter 10. Early archiving without OLE

Since SAP Release 4.6C the SAP Business Workflow can be triggered via the
ArchiveLink interface. CommonStore supports this new archiving scenario for
incoming documents beginning with version 7. To get this scenario working,
proceed as follows:
1. Set up the SAP workflow parameters and document types. See also Chapter 14,

“Collection of SAP customizing steps” on page 57.
2. Register the CommonStore Archiving Client application in the SAP system. See

also “Registering an OLE application in SAP” on page 58.
3. In SAP Release 3 you need to load the TypeLib information for the

CommonStore Archiving Client. See also “Loading the TypeLib information” on
page 58.

4. Create an entry in the link table for the document type used for early
archiving. See also “Creating an entry in the link table for the document type
used for early archiving” on page 59.
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Chapter 11. Late archiving with bar code

Late archiving with bar code is one of the most used scenarios for archiving
incoming documents. At SAP side you have to do different settings before using it:
1. Customize bar code storing for the object type you want to use, for example

BKPF by using transaction OAC5. For detailed information on setting up the
object types see the SAP documentation.

2. The SAP bar code types need to be checked and customized for your purposes.
Use transaction OAD4 for checking the settings. For detailed information check
the SAP documentation.

3. The SAP application you want to integrate must be enabled for late archiving
with bar code.

Look up more detailed information on SAP customizing for late archiving with bar
code in the SAP documentation.
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Chapter 12. Viewing documents via OLE

For viewing documents via OLE using the CommonStore Viewing Client you have
to do some SAP OLE customizing similar to the CommonStore Archiving Client.
Proceed as follows:
1. Register the CommonStore Viewing Client in SAP. See also “Registering an

OLE application in SAP” on page 58.
2. In SAP Release 3 you need to load the TypeLib information for the

CommonStore Viewing Client. See also “Loading the TypeLib information” on
page 58.

3. Create an ArchiveLink application for the CommonStore Viewing Client. See
also “Creating an ArchiveLink application” on page 58.

4. Customize the ArchiveLink application for viewing via the CommonStore
Viewing Client. See also “Customizing the ArchiveLink application for viewing
via the CommonStore Viewing Client” on page 61.

5. Create an ArchiveLink protocol. See also “Creating an ArchiveLink protocol” on
page 59.

6. Customize the ArchiveLink protocol for viewing via the CommonStore Viewing
Client. See also “Customizing the Archlink protocol for viewing documents” on
page 62.
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Chapter 13. Viewing print lists via SAP ArchiveLink

For viewing print lists you may use the SAP GUI or the SAP ArchiveLink viewer.
To get this working, you need to proceed as follows:
1. Create an ArchiveLink protocol. See also “Creating an ArchiveLink protocol” on

page 59.
2. Customize the ArchiveLink protocol for viewing print lists either via SAP GUI

or via the SAP ArchiveLink viewer. See also “Customizing the Archlink
protocol for viewing documents” on page 62.

3. Enable extended ALF viewing for viewing print lists with hyperlinks. See also
“Enabling extended ALF viewing” on page 62.
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Chapter 14. Collection of SAP customizing steps

The SAP Business Workflow is part of SAP ArchiveLink within the BC module. To
get the workflow working, you need to customize SAP ArchiveLink, which you
can do by using the Implementation Guide for R/3 Customizing (IMG).

Note
The IMG can be carried out by transaction code SPRO in all SAP releases up
to 4.6.

The workflow settings can be done within the IMG path R3 → Basis Components →
Basis Services → SAP ArchiveLink.
1. Customize the workflow basic settings. The implementation can differ between

SAP releases. The workflow setup can be checked by transaction SWU3. Each
check item has to be signed by a green hook, otherwise the settings have to be
corrected. See the SAP documentation for detailed information on this.

2. Customize the document types you want to use for your scenario. Document
types are used for linking them with several document classes, for example,
FIIINVOICE to FAX, which is needed for controlling storing and display
documents. Documents can be maintained in transaction OAC2.

3. Customize workflow document types to assign workflow tasks to the
document types you are using. This can be done in transaction SOA0. Either
the standard tasks or self-created workflow templates can be used. The
FIIINVOICE document type has the following default properties:

Process type NCI_INPUT

Object type BKPF

Object type CREATE

Task TS7869

For more detailed information, see the SAP documentation.
4. Create fast entries for the workflow document types. Use transaction code

OAD5. Depending on the SAP release level either a transaction opens or up
from release 4.5 a wizard opens.

Note
In later SAP releases the “fast entry” is called “presetting”. Both terms have
the same meaning.

For more detailed information about setting up the SAP Business Workflow see the
SAP documentation.
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Registering an OLE application in SAP
To register an application in the SAP system, proceed as follows:
1. Use transaction code SOLE. A panel appears.
2. Press the Change button.
3. Press the New entries button.
4. Enter the following settings:

CommonStore Archiving Client

OLE application CSCLIENT.DOCUMENT

CLSID {C8452EF3-19FE-11D1-A16E-0004AC62FCBA}

Type Info key NO_TYPELIB

CommonStore Viewing Client

OLE application OLEDISPA.DOCUMENT

CLSID {45526A21-AA41-11CF-B90A-0004ACED415F}

Type Info key NO_TYPELIB

5. Save the settings. This information enables the SAP GUI to detect the
executable of the CommonStore Archiving Client or the CommonStore Viewing
Client via the Windows registry.

Loading the TypeLib information
To load the TypeLib information for either the CommonStore Archiving Client or
the CommonStore Viewing Client, proceed as follows:
1. Use transaction code SOLI. A panel appears.
2. Highlight the application you have customized previously and press the Load

Type Info button. This setting will be used for the communication between the
SAP GUI and the CommonStore Clients.

Creating an ArchiveLink application
If it is necessary to create an ArchiveLink application, proceed as follows:
1. Press the New application button. Enter a logical name for the application (for

example CSARCH for the CommonStore Archiving Client) and press the
Continue button.

2. Click the Save button.

Customizing the ArchiveLink application for the CommonStore
Archiving Client

To customize the ArchiveLink application for archiving via the CommonStore
Archiving Client, proceed as follows:
1. Use transaction code OAA4. A panel appears.
2. Double-click the ArchiveLink application you want to customize, for example

CSARCH (for information on how to create a new ArchiveLink application see
“Creating an ArchiveLink application”). A list of ArchiveLink functions will be
displayed.

3. Highlight Archive from frontend (the fourth entry in the list).

58 CommonStore for SAP: Client Installation and User’s Guide



4. Depending on your SAP release, click the OLE button or double-click the
selected entry. A panel for setting up the OLE communication appears.

5. Enter settings as shown below:

Note
It is mandatory that the entries be specified in the following order.

Application CSCLIENT.DOCUMENT

Select radio button Command

M SetAID @AID

M doQueueArchive =@DID

G @EID =EID

Note
Make sure that the correct radio buttons are selected for the specified
command. When the radio button M is selected, the setting specified in the
Command column will be treated as a method. When the radio button S is
selected, the setting in the Command column will be used to set an attribute
in the CommonStore Archiving Client. When the radio button G is selected,
the setting in the Command column will be used to get the value of an
attribute from the CommonStore Archiving Client.

Creating an ArchiveLink protocol
If it is necessary to create an ArchiveLink protocol, proceed as follows:
1. Use transaction code OAA3.
2. Press the New protocol button. A panel appears.
3. Enter the following settings:

Protocol For example: CSPRT (logical name)

Version Choose the highest version, depending on the release of your R/3 System.
Note: In general, you should use the version corresponding to your SAP
system, for example 0031 for SAP Release 3.1. Never use 0040 because this
SAP protocol version has a bug.

Description Enter information on this protocol.

4. Click the Save icon.

Creating an entry in the link table for the document type used for early
archiving

Depending on the entries in the link table, SAP allocates archives to documents. To
create an entry in the link table for the document type used for early archiving,
proceed as follows:
1. Use transaction code OAC3. A panel appears.
2. Create an entry for the document type for which you want to perform early

archiving. For example: For incoming invoices without verification, you need
an entry with the following settings:
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Obj.type BKPF

Doc.type FIIINVOICE

Check whether there is already an entry in your link table with these settings.
If there is such an entry, you may update only the Arch.ID for this entry. To
create a new entry, proceed as follows:
a. Press the Change button. The panel turns into change mode.
b. Press the New Entries button.
c. Enter the following settings into the appearing form:

Object type Object type which the document type is from
(for example BKPF)

Document type Document type (for example FIIINVOICE)

Status X

Opt. archive ID Archive ID of the archive the documents should
be put in (for example A1)

Link Table for storing link data of archived
documents (for example TOA01)

Retention per. (leave blank)

Note
In newer SAP releases the fields can have different names, for example
Opt.archive ID is called content server in release 4.6.

d. Click the Save button.

Note
Check the entry for the object type you have customized, for example BKPF.
(For detailed information see also Checking the entry in the TOAOM table in the
IBM Content Manager CommonStore for SAP: Server Installation and User’s Guide.

Customizing the ArchiveLink protocol for archiving via the
CommonStore Archiving Client

To customize the ArchiveLink protocol for archiving via the CommonStore
Archiving Client, proceed as follows:
1. Use transaction code OAA3 . A panel appears.
2. Double-click the protocol to be customized, for example CSPRT (for

information on how to create a new ArchiveLink protocol, see “Creating an
ArchiveLink protocol” on page 59). A list of offered functions will be displayed.

3. Double-click Archive from frontend (the fourth entry).
4. Select the radio button for the document class FAX.
5. Press the Edit button. A panel appears:
6. Enter the following settings:

Comm. method OPEN

Application Enter the application you have customized previously, for
example CSARCH
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7. Press the Continue button and the panel disappears.
8. Use the Save icon to save the protocol settings.

Note
Only after setting Comm. method equal to OPEN will the edit box appear, in
which you can specify the application name.

Customizing the ArchiveLink application for viewing via the
CommonStore Viewing Client

To customize the ArchiveLink application for viewing via the CommonStore
Viewing Client, proceed as follows:
1. Use transaction code OAA4. A panel appears.
2. Double-click the ArchiveLink application you want to customize, for example

CSVIEW or CSARCH (for information on how to create a new ArchiveLink
application see “Creating an ArchiveLink application” on page 58). A list of
ArchiveLink functions will be displayed.

3. Highlight the Display object or the Display archived object entry (the first
entry in the list).

4. Depending on your SAP release click either the OLE button or double-click the
selected entry. A panel for setting up the OLE communication appears.

5. Enter the settings as shown. It is mandatory that you specify the entries in the
following order:

Application OLEDISPA.DOCUMENT

Select radio button Command

M SetUID @UID (see Note below)

M SetAID @AID

M doView @DID

G @EID =EID

Notes

v The OLE method SetUID is necessary only if you want to save the user
ID when processing notes via CommonStore.

v Make sure that the correct radio buttons are selected for the specified
command. When the radio button M is selected, the setting specified in
the Command column will be treated as a method. When the radio
button S is selected, the setting in the Command column will be used
to set an attribute in the CommonStore Archiving Client. When the radio
button G is selected, the setting in the Command column is used to get
the value of an attribute from the CommonStore Archiving Client.
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Customizing the Archlink protocol for viewing documents
To customize the ArchiveLink protocol for viewing via the CommonStore Viewing
Client, proceed as follows:
1. Use transaction code OAA3. A panel appears.
2. Double-click the protocol to be customized, for example CSPRT (for

information on how to create a new ArchiveLink protocol, see “Creating an
ArchiveLink protocol” on page 59). A list of offered functions is displayed.

3. Depending on the SAP release, click the Display object or the Display
archived object entry (first entry in the list).

4. Select the document class you want to customize, for example ALF for print
lists, FAX for incoming documents.

5. Click the Edit button.
6. Enter the following settings:

Comm. method Either OPEN (for FAX), R/3 (for ALF), or standard
communication (for FAX and ALF)

Application Enter the application you have customized previously, for
example CSVIEW (only if Comm.method OPEN was selected)

Note

v For viewing print lists within the SAP GUI choose communication method
R/3. Starting with SAP Release 4.5/4.6 print lists with hyperlinks can also
be viewed in the SAP GUI. Selecting communication method Standard
communication, the SAP ArchiveLink viewer will be used for viewing. The
SAP ArchiveLink viewer is only delivered up to SAP Release 4.5.

v For viewing documents (except print lists) via OLE you have to choose
communication method OPEN.

Enabling extended ALF viewing
To enable extended ALF viewing, proceed as follows:
1. Use transaction code RZ10 and RZ11.
2. Choose the profile of the SAP R/3 System and add the parameter as follows:

rspo/archive_format=2

Customizing the ArchiveLink application for closing a viewer window
The ArchiveLink interface can call OLE functions in the ArchiveLink application
for closing the viewer window when the transaction viewing was started from is
left. This mechanism prevents wasting resources on the client workstation. If the
CommonStore Viewing Client gets a doCloseWindow call, it closes the current
viewing application instance. To set up OLE communication in the SAP system,
follow these steps:
1. Use transaction code OAA4. A panel appears.
2. Double-click the ArchiveLink application you customized for displaying a

document, for example CSVIEW. A list of ArchiveLink functions will be
displayed.

3. Highlight the function Close window.
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4. Depending on your SAP release, click either the OLE button or double-click the
selected entry. A panel for setting up the OLE communication appears.

5. Enter the following settings:

Application OLEDISPA.DOCUMENT

Select radio button Command

M doCloseWindow
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Part 5. User’s guide
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Chapter 15. Working with the CommonStore Archiving Client

After having installed and configured the CommonStore Archiving Client, created
the CommonStore queues, and saved the working environment to a CommonStore
Archiving Client file with the extension .csw, you can restore this session at any
time simply by opening the file in the CommonStore Archiving Client.

CommonStore Archiving Client GUI
The CommonStore Archiving Client’s GUI provides the following operating
facilities:
v The menu bar (for example File or Edit). By clicking on one menu entry, the

submenus of this entry will be displayed.
v The tool bar is a list of graphic symbols, each of which stands for a shortcut to a

certain menu entry.
v Context menus, which will be displayed when clicking an item with the right

mouse button.
v Two frames displaying the queues and documents which you are working on.

After having imported documents (see “Importing documents”) into the
CommonStore Archiving Client, the two frames of the GUI will be populated as
shown in Figure 1 on page 14.

The left frame is mainly used for displaying the structure of the CommonStore
queues. The hierarchy of the structure comprises the following levels:
v The topmost level is the queue level.
v The next-lower level is the document level.

You can make the next-lower level visible by clicking the + sign. This is referred to
as expansion.

Several documents may be available in a queue. By expanding a queue entry, all
the documents contained in that queue will be listed.

The right frame will be used mainly for selecting the documents to be archived or
for displaying the contents of a document.

In the status line, information on the status of an action will be displayed. It is
very useful in error situations. The box in the middle first displays the number of
documents currently in the active queue and then the number of the selected
documents in the active queue. The right box in the status line displays the
connection status with the CommonStore Server by text and icons (see also
Figure 1 on page 14).

You can switch between the left and the right frame by using the TAB key.

Importing documents
To fill the CommonStore queue with previously-scanned documents, you first have
to select the queue that you want to import in the left panel. You can use the
following methods of importing:
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v Select Import from the context menu appearing when clicking the right mouse
button on the queue.

v Select the menu path Queue → Import from the application menu.
v Press Alt+F1.

Due to the previously defined settings, when creating the CommonStore queue, the
CommonStore Archiving Client finds the scanned documents in the specified
location and imports them. The documents will be listed from top to bottom in
alphabetical order. Each document is identified by the name, the bar code (if
applicable), and the creation date.

After having imported documents into a queue the list of documents can be
expanded by clicking the plus sign next to the queue name.

You can observe the importing activity in the right frame, where an entry will be
added for each imported document.

Stopping importing
An import process can be canceled by one of the following actions:
v Double-clicking the queue.
v Selecting Stop importing from the context menu that opens when you right-click

the queue name.
v Clicking Queue → Stop importing on the main menu.
v Pressing Alt+F2.

Viewing documents
A highlighted document in the right frame can be viewed by double-clicking this
entry. You can also select View document from the context menu or press Alt+V.

Viewing documents is done by a Microsoft Internet Explorer ActiveX Control to
display all document types in one viewer assuming you have installed the correct
plug-ins. If you have installed, for example, the Adobe Acrobat Reader, the
corresponding Microsoft Internet Explorer plug-in is installed as well. For viewing
TIFF documents you can use, for example, the AlternaTIFF plug-in.

Note
If you are using Microsoft Windows 2000, a Wang Image plug-in for viewing
TIFF documents is part of the operating system.

Archiving documents
You can archive individual documents or an entire queue. In addition, you may
archive documents automatically, that is, unattended, at regular intervals.

You can observe the archiving activity in the right frame, where the document
stack diminishes with each successfully archived document.

Archiving documents manually
In the right frame, select the document to be archived by clicking it. A colored
selection bar will give you visual proof of your selection. If you want to select
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more than one document, keep the Shift or Ctrl key pressed while clicking
additional documents. Press Ctrl+A to select all documents in the selected queue.
Depending on which archiving scenario you are using, select Late archiving or
Early archiving from the context menu or from the Document menu. From the
submenus, select either Archive selected item(s) for archiving the selected items
only or Archive all items for archiving all items in the queue.

Archiving all items in a queue
Depending on which archiving scenario you are using, start archiving by one of
the following actions.

Late archiving:
v Selecting Late archiving from the context menu of the left frame.
v Clicking Queue → Late archiving.
v Pressing Alt+F6.

Early archiving:
1. Selecting Early archiving from the context menu of the left frame.
2. Clicking Queue → Early archiving

3. Pressing Alt+F5.

Note
Early archiving is enabled only if the connected CommonStore Server is
version 7 or later and if the document type for the dedicated queue is
customized (see also “Creating queues” on page 25).

Stopping archiving
An archiving session can be canceled by selecting Stop archiving → Queue → Stop
archiving from the context menu or by pressing Alt+F7.

Deleting documents
Deleting documents works only if neither importing nor archiving is in progress
for the selected item.

Select the items to be deleted. Choose Delete document from the context menu or
menu path Document → Delete document. Alternatively, hit the Delete key or
press Alt+D.

You will be asked whether the document is supposed to be deleted only from the
CommonStore Archiving Client’s GUI only or if the electronic document should be
deleted from the file system as well.

Note
For security reasons, it is not possible to delete electronic documents residing
in a Content Manager workbasket directly from the CommonStore Archiving
Client.
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Resetting the error flag
If an error has occurred while archiving, an error flag for this queue will be set
and you will be made aware of it by a warning when trying to start a new
archiving process. If you decide to continue, the error flag will be reset based on
the assumption that the problem may have been fixed in the meantime.

It is also possible to reset the error flag by highlighting a queue in the left frame
and choosing Reset error flag from the context menu.

Switching server connections
The CommonStore Archiving Client allows you to choose between several
CommonStore Server connections. This gives you the opportunity to redirect the
archiving workload in your queues, which might be useful if, for example, the
server that you usually connect to is very busy.

When you start the CommonStore Archiving Client, it connects to a default server.
This connection is called the preferred server connection. You enter the details of the
preferred connection when you first start the CommonStore Archiving Client, but
you can also change it later.

Important

v Content Manager queues can only use the preferred server connection. To
create multiple Content Manager queues connecting to different servers,
you must therefore specify the preferred server connection before creating
the queue. See “Creating queues” on page 25.

v You cannot change the server connection of any queue while automatic
processes are running.

If you decide to use more CommonStore Servers for your archiving jobs, you can
add the parameters for additional connections to existing queues. You do this by
changing the connection settings on the property sheet of a queue. The archiving
client then switches to the new connection.

Each connection that you use or did use is listed in the Connections Information
window, which gives you the details of the active connection and the inactive ones.
You open this window by clicking Queue → Connections Info on the main menu
of the archiving client. You can view and refresh this information at any time.

You need not worry about older files containing queue connection details, that is,
.csw files created with older versions of the CommonStore Archiving Client. When
the archiving client comes across such files, it automatically migrates them to the
new format so that the new functionality becomes available for the existing
queues. You are prompted to save the files in the new format. If you decide not to
do this, you can still save the migrated versions under a different name by clicking
File → Save As on the main menu.

Changing queue connections
This section explains how to change the connection parameters and thus change
the server connection of an existing queue. For information on how to set up a
queue connection when creating a queue, see “Creating queues” on page 25 and
“Connection Properties panel” on page 30 in particular. Follow these steps:
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1. After starting the CommonStore Archiving Client, create a queue, or open an
existing queue.

2. Right-click the name of the queue in the left pane.
3. Select Properties from the context menu. The property sheet of the queue

opens.
4. Click the Connections tab. Change the values in the following fields to the

proper values for the new connection.

Archive Host/IP Address
The name of the CommonStore Server that you want to connect to. You
can enter the short name, the full name, or the IP address.

Port The number of the port that is used for client/server communication
regarding archiving and retrieval jobs. This port uses a TCP/IP
connection. The actual value depends on the individual setup. Ask the
administrator of the CommonStore Server for the correct port number.
It is a 4-digit number that is greater than 5000.

WebPort
The number of the port that is used for client/server communication
regarding the display of archived documents. Client and server
communicate by using the Hypertext Transfer Protocol (HTTP), which
is why the port is called the WebPort. The actual value depends on the
individual setup. Ask the administrator of the CommonStore Server for
the correct port number.

5. Click Test to check whether your new connection works. The archiving client
indicates a working connection by a green light. If the connection does not
work, you see a red cross.

6. Click OK. The CommonStore Archiving Client now uses the connection whose
parameters you just entered.

Important

v You cannot change the server connection of a Content Manager queue
because Content Manager queues always use the preferred server connection.

v You cannot change the server connection of any queue while automatic
processes are running.

Changing the preferred server connection
The preferred server connection is the connection that the CommonStore Archiving
Client establishes first when you start it. The procedure of changing this
connection is much similar to that of switching a connection. Follow these steps:
1. After starting the CommonStore Archiving Client, click Setup → Run setup.
2. Enter the proper values of a server connection in the following fields:

v Archive Host/IP Address

v Port

The meaning of these fields is described in step 4. You need not enter a port
number in the WebPort field because this is done automatically when you
proceed with step 3.

3. Click Test to check whether the new connection works. The archiving client
indicates a working connection by a green light. If the connection does not
work, you see a red cross.
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4. Click OK. The CommonStore Archiving Client switches to the new preferred
server connection and saves its details. The server connections of existing
queues are not affected by this change. When you close the archiving client and
restart it, it establishes a connection based on the new parameters.

Important
You cannot change the preferred server connection while automatic processes
are running.

Displaying the connection status
As indicated in the introductory section, you can display information about the
various server connections that you use. Click Queue → Connections Info. This
brings up the window shown in Figure 13.

The Connections Information window displays the details of all current server
connections. This includes information about the queues that the connections are
related to, the port numbers, whether or not the connection is currently used,
available or not available, and the SAP R/3 parameters.

If the connection status changes while the window is open, you can click the
Refresh button to reflect these changes on the display. Click Close to close the
Connections Information window.

Important

v To display the connection status, you must select a queue in the left pane
of the window.

v You cannot display the connection status while automatic processes are
running.

Panel functions
This section provides an overview of the actions that you can perform by using the
main menu.

Figure 13. The Connections Information window
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Menu
The menu consists of key words, for example File or Queue.

File menu
The File menu allows you to handle files, that is, to open an existing file or to
create a new one. A pop-up menu gives you the choice of: New, Open, Save, Save
as, and Exit. In the following explanations, the associated tool bar icon providing a
shortcut to that entry is displayed.

New
Creates a new CommonStore Archiving Client session.

Open
Enables you to reopen a CommonStore Archiving Client session by loading
the corresponding CommonStore file. A file selection box will be displayed,
where you can browse through your file system and select the
CommonStore file to be loaded. CommonStore files have the extension
.csw. After loading a CommonStore file, the name of the opened file
appears on the title bar.

Save
Enables you to save the settings of the current CommonStore archiving
client session in a CommonStore file. When saving a CommonStore session
for the first time, a file selection box will be displayed, where you can
browse through your file system and select the directory and file name to
which the CommonStore session should be saved. A CommonStore file will
then be created with the specified name. CommonStore files have the
extension .csw. After saving the current session, the name of the saved file
appears on the title bar. If you subsequently choose to save the current
session, no more file selection boxes will appear, but the changes will be
recorded in the name displayed in the title bar.

Save as
Works similar to Save when saving a CommonStore session for the first
time. It also allows you to create a duplicate of the loaded CommonStore
file under a new name.

Exit Allows you to exit the application. If you performed changes during the
current CommonStore session and they have not been saved before, you
will be prompted to save the changes.

Queue menu
The Queue menu allows you to specify all actions you want to perform on the
selected queue:

New queue (Ctrl+I)
Calls the panels needed for allocating a new CommonStore queue.

Delete (Ctrl+D)
Removes the selected queue from your working environment.

Properties (Ctrl+Shift+P)
Shows the property dialog for the selected queue.

Import (Alt+F1)
Starts an importation action for the highlighted queue. This menu entry is
enabled only if the selected queue is not importing already.
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Stop importing (Alt+F2)
Stops the importation action for the highlighted queue. This menu entry is
enabled only if the selected queue is importing.

Early archiving to WFL (Alt+F5)
Starts an early archiving action for the highlighted queue. This item is
enabled only if the connected server is a CommonStore Server Version 7 or
later, if the document type of the queue is customized (see also “Creating
queues” on page 25), and if the queue is not archiving already.

Late archiving (Alt+F6)
Starts a late archiving action for the highlighted queue. This item is
enabled only if the queue is not archiving already.

Stop archiving (Alt+F7)
Stops the archiving action of the highlighted queue. This menu entry is
enabled only if there is an archiving action running for the queue.

Connections Info (Ctrl+F1)
Displays information about the server connections. This menu entry is
enabled only if there are existing queues. See “Switching server
connections” on page 70 for more information.

Document menu
The Document menu allows you to specify all actions you want to perform on the
selected document(s) of the active queue.

Early archiving to WFL

The appended submenus allow you to perform an early-archiving-
operation on the following documents:
v Selected documents. To do so, click Archive selected item(s)

v All documents in a queue. To do so, click Archive all items or press
Alt+F5.

The submenu items are enabled only if the connected server is a
CommonStore Server Version 7 or later, if the document type of the queue
is customized (see also “Creating queues” on page 25), and if and the
queue is not archiving already.

Late archiving

The appended submenus allow you to perform a late-archiving-operation
on the following documents:
v Selected documents. To do so, click Archive selected item(s)

v All documents in a queue. To do so, click Archive all items or press
Alt+F6.

The submenu items are enabled only if the queue is not archiving already.

Stop archiving (Alt+F7)
Stops the archiving action for the active queue. This menu entry is enabled
only if there is an archiving action running for the queue.

Delete document (Alt+D)
Removes the selected documents from the queue. You will be prompted to
remove the document files from the file system as well. Alternatively you
can press the Delete key.

View document (Alt+V)
Views the selected document in the right frame.
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Setup menu
The Setup menu allows you to specify and change the essential settings for the
CommonStore Archiving Client.

Run setup (Alt+F8)
A dialog appears in which you can specify your settings for the
CommonStore Archiving Client and for the CommonStore Server to be
contacted. These settings include:
v Trace file
v Log file
v API-DLL trace file
v Work path for the CommonStore Archiving Client
v Number of bar codes to be sent to SAP R/3 in a batch when performing

late archiving.

To create queues, you must load modules. For detailed information see
“Setting up the CommonStore Archiving Client” on page 21.

Save settings to file
This menu item is needed for propagating the CommonStore Archiving
Client to other workstations. See “Distributing the CommonStore Archiving
Client to other PCs” on page 32.

Automatic processing menu
The Automatic processing menu allows you to specify at which intervals an
automatic import with subsequent archiving should be performed for all allocated
queues in the current session.

Enable (Alt+F9)
Allows you to specify the time interval between two automatic processes.
You must select the early-archiving or the late-archiving mode for all
queues. Additionally, you can select whether the automatic processing
should be stopped if an error occurs.

Stop (Alt+F10)
Stops the automatic processing.

Important
While automatic processes are running, you cannot perform the following
tasks:
v Create queues
v Change queue properties
v Switch server connections
v Change the preferred server connection
v Display the connection status

View menu
The View menu lets you hide/view the tool bar and the status bar.

Help menu
The Help menu lets you display information about the product and its version.
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Chapter 16. Perform early archiving without OLE

Early archiving without OLE is performed without SAP GUI. On the Client side
you need entirely the CommonStore Archiving Client. Before performing early
archiving without OLE for the first time, you must check the following items:
1. Check the SAP customizing (see Chapter 10, “Early archiving without OLE” on

page 49).
2. The queue you want archive documents from needs to be customized for early

archiving by entering the correct document type into the queue panel (see
“Creating queues” on page 25).

3. Check that the CommonStore Client is connected to a CommonStore Server
Version 7 or later.

Follow these steps for performing early archiving:
1. Import documents into the queue you want to archive from. See also

“Importing documents” on page 67.
2. Select the documents you want to archive or the queue for archiving all

documents of the queue.
3. Perform the early archiving action. See “Archiving documents” on page 68 for

details.

Successfully archived documents disappear from the CommonStore Archiving
Client, otherwise an error message is displayed.

Note
The early archiving process can be started periodically for all queues of the
running session by using the Automatic Processing feature of the
CommonStore Client. Refer to Chapter 19, “Automatic processing” on page 83
for more detailed information on this.
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Chapter 17. Perform early archiving with OLE

Early archiving with OLE requires running the SAP GUI. Additionally the
CommonStore Archiving Client is needed for OLE communication and performing
archiving. Before using this scenario for the first time:
1. Check the SAP customizing (see Chapter 9, “Early archiving via OLE” on

page 47).
2. Ensure that the CommonStore Archiving Client is connected to any

CommonStore Server.

Follow these steps for performing early archiving:
1. For SAP releases up to 4.5, click Office → Optical archiving → Early Archiving.

For SAP Release 4.6, click Office → Business Documents → Documents → Move.
2. Choose the SAP fast entry or presetting (in SAP Release 4.6) which your

document type belongs to and double-click the entry. A new panel appears.
3. Now SAP offers you the following ways of archiving documents:

a. If you press Continue or the green hook (depending on the SAP release),
one OLE call for early archiving will be sent to the CommonStore Archiving
Client, which archives either the first document of the active queue or the
first selected document in the active queue.

b. If you press the Mass archiving button, subsequent OLE calls for early
archiving will be sent to the CommonStore Archiving Client until all the
documents in the active queue have been archived.

Important
CommonStore archives only those documents that you selected in the
queue. If you selected only one document, clicking Mass archiving
results in the archiving of just this one document.

For each archived document a work item will be created in the inbox of the
organizational object customized for early archiving of this document type. An
organizational object can be a user, a group of users or a job to which a group of
users has been assigned.

Note
If you are using single document archiving, you get a “Scan queue empty”
message from SAP if you try to archive a subsequent document. You need to
click the Continue button again for archiving a further document.
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Chapter 18. Perform late archiving with bar code

Late archiving requires no SAP GUI on the client side. However, before using this
scenario for the first time:
1. Check the SAP customizing for late archiving with bar code (see also

Chapter 11, “Late archiving with bar code” on page 51).
2. Check the Archive setup in the server configuration profile (default archint.ini)

for the archives that you want to use. The LOGICAL_SYSTEM keyword within
the ARCHIVE statement has to point to the correct logical SAP system for
uploading the bar codes.

3. Ensure that the CommonStore Archiving Client is connected to any
CommonStore Server.

For performing late archiving, proceed as follows:
1. Import documents into the queue you want to archive from (see also

“Importing documents” on page 67).
2. Select the documents you want to archive or the queue for archiving all

documents of the queue.
3. Perform the late archiving action (see “Archiving documents” on page 68 for

details).

Successfully archived documents disappear from the CommonStore Archiving
Client, otherwise an error message is displayed.

Note
The late archiving process can be started periodically for all queues of the
running session by using the Automatic Processing feature of the
CommonStore Client. Refer to Chapter 19, “Automatic processing” on page 83
for more detailed information on this.
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Chapter 19. Automatic processing

To import and archive documents for all queues at regular intervals and
unattended, select the menu entry Autom. Processing → Enable. In the appearing
dialog you can choose the interval between two times of execution and the
archiving method. Enter the following settings:

Value Numeric value of the interval

Time Unit Time unit (hours, minutes) of the interval

Note
Thus, if you specify a value of 5 and minutes as the time unit,
new documents are imported and archived every five minutes.

Archiving method Select the archiving method you want to be performed periodically
on all queues of the running session. By default late archiving with
bar code is used.

Note
Archiving method early archiving to WFL can be selected only
if the connected server is a CommonStore Server Version 7 or
later, and if the document type is customized for all queues. See
“Installing the package” on page 16 for detailed information on
customizing the document type.

Figure 14. Automatic processing
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Stop on error Check if you want a message to be displayed in case of an error
during automatic processing runs. Leaving this check box unchecked
generates log file entries only if errors occur.

Start automatic processing by clicking the OK button. Clicking the Cancel button
discards your settings for automatic processing.

Immediately after starting automatic processing, for each queue in the current
session import and archive actions will be started. These actions will be repeated
after the specified time is up.

Important
While automatic processes are running, you cannot perform the following
tasks:
v Create queues
v Change queue properties
v Switch server connections
v Change the preferred server connection
v Display the connection status
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Chapter 20. Viewing documents via OLE

CommonStore supports viewing archived documents via the OLE interface. To get
this scenario working:
1. Check the SAP customizing for document viewing via OLE. See also

Chapter 12, “Viewing documents via OLE” on page 53.
2. Check if the CommonStore Viewing Client is installed and set up for either

native viewing or browser viewing. See also “Installing the package” on
page 16.

3. View a document from the archive in which the transaction corresponding to
your action is stored. For example, for viewing documents assigned to a
financial accounting document, click Environment → Object Links. Select the
Archived documents radio button in the Choose Object Links panel. A list of
archived documents linked to this financial accounting document will be
displayed. Double-click the archived document that you wish to display. The
CommonStore Viewing Client, started by the SAP GUI via OLE, will launch the
customized viewing application.

Note
If you are using browser viewing you may append notices to the documents
by the process note applet or send the document to another clerk via the
mailing applet.

Process note applet
When displaying an archived document, CommonStore offers the possibility of
adding notes, which will be archived too. Archiving notes makes it easier to share
information on archived documents and on business processes connected to the
archived documents. The look and feel when creating a note with CommonStore is
similar to that of creating a note using the SAP ArchiveLink viewer. New notes
will be appended to the existing ones. The note’s date and time of creation will be
saved. If SAP is customized to also send user information to CommonStore, this
information will also be archived. Notes created using the ArchiveLink Viewer are
compatible with notes created using CommonStore.

Note
To be able to attach notes to a document, you need the CommonStore Server
release 2.x or later.

Mailing applet
When using a browser for displaying a document, the browser facilities can be
used for sending e-mails and attaching the archived document to this e-mail. But if
you have the possibility of archiving notes to a document, you also want to have
the option of sending them by e-mail. Using the CommonStore e-mailing feature
makes it possible to send an archived document in addition to the archived notes
for this document.
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Note
To send the archived document as an e-mail including the attached note via
CommonStore, you need the CommonStore Server release 2.1.5.0 or later.

You must specify the mail server to be contacted for sending e-mails in the
server configuration profile (that is, archint.ini). You do this with the help of
the MAILSERVER keyword.
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Chapter 21. Viewing print lists via SAP ArchiveLink

For viewing print lists via SAP ArchiveLink, proceed as follows:
1. Check the SAP customizing for viewing print lists. See also Chapter 13,

“Viewing print lists via SAP ArchiveLink” on page 55.
2. Check the settings for the SAP ArchiveLink viewer. See also “Viewing

documents with the SAP ArchiveLink viewer” on page 39.
3. Use the transaction code OADR for accessing print lists. A search panel

appears.
4. Enter your selection criteria.
5. Press the Execute button to get a hit list of all print lists matching your search

criteria.
6. Highlight the print list to be viewed.
7. Press the Display from archive button.

Depending upon the settings in the communication protocol (see “Customizing the
Archlink protocol for viewing documents” on page 62) the print list will be viewed
in the SAP GUI or the SAP ArchiveLink viewer.
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Deutschland
Informationssysteme GmbH
Department 3982
Pascalstrasse 100

© Copyright IBM Corp. 1999, 2002 89



70569 Stuttgart
Germany

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement
or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1997, 2002. All rights reserved.
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If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
The following terms are trademarks of the IBM Corporation in the United States,
other countries, or both:

AIX

EDMSuite

IBM

ImagePlus

iSeries

Operating System/2

Operating System/400

OS/2

S/390

Tivoli

VisualInfo

z/OS

zSeries

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Lotus, Domino, and Lotus Notes are trademarks of Lotus Development
Corporation in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, and service names may be trademarks or service marks
of others.
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